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  PREFACE
Trademarks ® and Copyrights ©

Scanivalve is a registered trademark of Scanivalve Corpora-
tion.

All other brand and product names are trademarks or regis-
tered trademarks of their respective companies.  

Important Notice

Please note that the product specifications and other 
information contained in this manual are subject to change 
without notice.  Scanivalve Corporation makes an effort and 
strives to provide complete and current information for the 
proper use of the equipment.  If there are any questions 
regarding this manual or the proper use of the equipment, 
contact Scanivalve Corporation.

Contact Information

If there are any questions or concerns regarding any Sca-
nivalve product please do not hesitate to contact us at the 
following:

Scanivalve Corp.
1722 N. Madson Street
Liberty Lake, WA 99019

Telephone: (800)935-5151   (509)891-9970
Fax: (509)891-9481

scanco@scanivalve.com
www.scanivalve.com

Scanivalve Corporation is an ISO9001:2008 certified com-
pany.
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SECTION 1: INTRODUCTION
Overview

The Sensor Replacement Utility was developed as an easy 
to use method to move sensor coefficients.  It is compatible 
with:

•  DSA3007
•  DSA3207
•  DSA3307
•  DSA3017
•  DSA3018
•  DSA3217

•  DSA3218
• DSA3016
• ZOC17
• ZOC22
• ZOC23
• ZOC33

The software is designed to upload and download Sensor 
Profile Files (.spf files).  

System Requirements

Windows XP SP3 or Windows 7
Pentium IV or better processor
512 Mb RAM
Microsoft Framework.net V2.0 or higher*

 *.NET Framework is available as a free download from Microsoft

Installation

To install the software,
1. Place the installation CD in a CD or DVD drive

2. Click Start, then Run.
3. Select Browse.

4. Open the drive where the CD is installed, highlight 
Setup.exe and click Open.

5. Click OK in the ‘Run’ window to begin the installation.
6. Follow the on screen prompts to complete the instal-

lation.

If the Sensor Replacement Utility has been downloaded 
from the Scanivalve website, unzip the file and double-click 
the Setup.exe file.  Follow the on screen prompts to com-
plete the installation.
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SECTION 2: OPERATION
Getting Started

The main window of the Sensor Replacement Utility can be 
seen in “Figure 2.1 - Main window”.  It is made up of the 
menus across the top in traditional Windows format, the 
IP Address field, the Module Position field, Sensor Position 
field and the status panel.  

Under the File menu (“Figure 2.2 - File Menu”) are three 
options:

‘Create SPF...’ - This option downloads coefficients from 
a specified channel of a specified module and creates a 
Sensor Profile File (.spf).  

‘Open SPF...’ - This option uploads a Sensor Profile File 
(.spf) to the specified channel of a specified module.

‘Exit’ - This option closes the Senor Replacement Utility.

Under the Configuration menu (“Figure 2.3 - Configuration 
window”) are three options:

‘DSA’ - This option configures the Sensor Replacement 
Utility for communications with DSA series modules 
with temperature coefficients less than 72°C.

‘DSA Temperature Segmented’ - This option configures 
the Sensor Replacement Utility for communications 
with a DSA series module with temperature coef-
fiecients ranging from 0 to 72°C.

‘Enclosure’ - This option configures the Sensor Replace-
ment Utility for communications with DSAENCL, rack 
mounted data systems.  The Module Position field will 
be enabled when this option is selected.

‘DSM/RAD’ - This option configures the Sensor Replace-
ment Utility for communications with either DSM or 
RAD series data acquisition systems.  The Module Posi-
tion field will be enabled when this option is selected.

Figure 2.1 - Main window

Figure 2.2 - File Menu

Figure 2.3 - Configuration window
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The Help menu (“Figure 2.4 - Help Menu”) provides one 
option:

‘About’ - This option provides basic information about 
the Sensor Replacement Utility including the software 

version.

The IP Address field (“Figure 2.5 - IP Address Field”) is a 
configurable field used to define the IP Address of the 
module being communicated with.  Simply enter the 
IP Address of the module being communicated with 
before attempting to establish a connection.

The Module Position field (“Figure 2.6 - Module Position 
Field”) is a configurable field used to define the module 
number that the Sensor Profile File (.spf) will be uploaded 
to or downloaded from.  This field is only activated when 
‘Enclosure’ or ‘DSM/RAD’ option is selected in the configu-
ration drop-down.  The module position can be changed by 
either clicking the up and down arrows or manually enter-
ing the desired channel. 

Figure 2.5 - IP Address Field

Figure 2.6 - Module Position Field

*NOTE: DSA, ENCL, DSM and RAD software references channels starting with 0, while the hardware is numbered starting with 1.  The Sensor Replacement Utility uses 1-X numbering.

Figure 2.4 - Help Menu
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The Sensor Position field, (“Figure 2.7 - Sensor Position”) 
is a configurable filed used to define the position that the 
Sensor Profile File (.spf) will be uploaded or downloaded 
from.  The numbering used in this field starts at 1*.  The 
sensor position can be changed by either clicking the up 
and down arrows or manually entering the desired chan-
nel. 

The Status Panel (“Figure 2.8 - Status Panel”) is a text 
window on the main screen that displays information about 
the configuration and activity during a Sensor Profile File 
(.spf) creation or upload.  The text in the Status Panel is 
not editable, however it can be selected, copied and pasted 
into a text document for review or archiving.  

The ‘Clear Status Panel’ button (“Figure 2.9 - Clear Status 
Panel Button”) is located above the Status Panel.  When 
clicked, all text displayed in the Status Panel is cleared.  The 
data displayed in the Status Panel can very quickly become 
cluttered and difficult to sort through, this feature makes it 
very easy to eliminate unwanted data.  

The Debug option (“Figure 2.10 - Debug Option”) either 
enables or disables additional debug information to be 
printed to the status panel.  This information is not needed 
for most applications however it provides useful infor-
mation when trying to understand problems with the 
software.

Figure 2.8 - Status Panel

Figure 2.9 - Clear Status Panel Button
Figure 2.7 - Sensor Position

Figure 2.10 - Debug Option
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Creating a Sensor Profile File (.spf)

The ability to create a Sensor Profile File (.spf) is used when 
a sensor is being moved from one position to another.  This 
can also be done between modules.  The procedure for 
removing and replacing sensors is covered in detail in the 
appropriate DSA and ZOC hardware manuals.  Take great 
care with this procedure as damage can easily be done to 
the sensor and/or the module.  It is recommended before 
moving a sensor from one module to the next you contact 
Scanivalve Corp. to confirm compatibility.   

Before removing the sensor from the original module, a 
Sensor Profile File (.spf) should be created.  The .spf file 
contains all of the sensor’s unique calibration coefficients 
as well as it’s associated configuration variables.  

Begin by configuring the Senor Replacement Utility.  

1. Under the Configuration drop-down, select the type of 
equipment you will be communicating with.

2. Enter the IP Address of the module in the IP Address 
field*.

3. If working with a Enclosure, DSM or RAD, select the 
position of the appropriate module in the Module 
Position field.

4. Select the sensor position (channel number) in the 
Sensor Position field.

5. Enable or disable the ‘Debug’ function as desired.
6. Under the ‘File’ menu, select ‘Create SPF...’.

7. A window will open to allow you to input the desired 
name of the Sensor Profile File (.spf) to be created.  
Navigate to the desired directory where the .spf file 
will be created, then put the desired file name of the 
.spf file in the ‘File Name’ field.  

8. Click ‘Save’ and the Sensor Replacement Utility will 
create the Sensor Profile File (.spf) in the specified 
location.

9. Navigate to the specified directory and confirm that 
the Sensor Profile File (.spf) was successfully created.

A Sensor Profile File (.spf) can be opened and viewed using 
any text editor such as Notepad or Microsoft® Word. 

*NOTE: Ensure that the IP Address of the module is compatible with the IP Address of the host computer.  For more information on this, contact Scanivalve.

Figure 2.11 - Create SPF

Figure 2.12 - Save .spf File
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Uploading a Sensor Profile File (.spf)

When a sensor is relocated in a module or a new sensor is 
installed, the unique calibration coefficients associated with 
the sensor need to be uploaded to the module.  The Sensor 
Profile File (.spf) contains all of these unique calibration 
coefficients as well as the configuration variables associ-
ated with the sensor.  

All replacement sensors are delivered from Scanivalve with 
the associated Sensor Profile File (.spf).  If the sensor is 
being removed from another module, the Sensor Profile 
File (.spf) can also be created from the old module before 
the sensor is removed using the Sensor Replacement Util-
ity.  See the “Creating a Sensor Profile File (.spf)” on page 
6 of this manual for more information on creating .spf 
files.

To upload a Sensor Profile File (.spf), begin by configuring 
the Sensor Replacement Utility software:

1. Under the Configuration drop-down, select the type of 
equipment you will be communicating with.

2. Enter the IP Address of the module in the IP Address 
field*.

3. If working with a Enclosure, DSM or RAD, select the 
position of the appropriate module in the Module 
Position field.

4. Select the sensor position (channel number) in the 
Sensor Position field.

5. Enable or disable the ‘Debug’ function as desired
6. Under the ‘File’ menu, select ‘Open SPF...’. 

7. A window will open to allow you to select the desired 
Sensor Profile File (.spf) to be uploaded.   Select ‘Open’ 
to begin uploading the Sensor Profile File (.spf) to the 
DSA module.  

8. To confirm that the upload was successful, connect 
to the DSA module through Telnet, HyperTerminal or 
another Ethernet communications venue.  Send the 
command:

list mi X 0 69
(X  = the sensor location the .spf file was uploaded to.  Note that here a 0-15 channel 

numbering system is used.  If a .spf file was uploaded to channel 1 through the Sensor 

Replacement Utility, ‘list mi 0 0 69’ would display the uploaded coefficients.)

  

Figure 2.13 - Open SPF

Figure 2.14 - Select .SPF file to upload
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APPENDIX A - SAMPLE SENSOR 
PROFILE FILE (.SPF)
SET TEMPM0 595.000000
SET TEMPB0 -14075.000000
SET ABS0 0
SET MAX0 0.210000
SET MIN0 -0.210000
SET NEGPTS0 4
INSERT 0 0 -0.200240 -15093 M
INSERT 0 0 -0.149860 -11376 M
INSERT 0 0 -0.100210 -7667 M
INSERT 0 0 -0.049350 -3897 M
INSERT 0 0 0.000000 -233 M
INSERT 0 0 0.049030 3401 M
INSERT 0 0 0.100280 7209 M
INSERT 0 0 0.150260 10907 M
INSERT 0 0 0.200420 14608 M
INSERT 5 0 -0.200140 -15066 M
INSERT 5 0 -0.150300 -11374 M
INSERT 5 0 -0.100320 -7667 M
INSERT 5 0 -0.049090 -3878 M
INSERT 5 0 0.000000 -230 M
INSERT 5 0 0.049610 3451 M
INSERT 5 0 0.099560 7142 M
INSERT 5 0 0.150160 10883 M
INSERT 5 0 0.200270 14573 M
INSERT 15 0 -0.200160 -14986 M
INSERT 15 0 -0.150210 -11293 M
INSERT 15 0 -0.099660 -7583 M
INSERT 15 0 -0.049790 -3892 M
INSERT 15 0 0.000000 -203 M
INSERT 15 0 0.049840 3482 M
INSERT 15 0 0.099920 7181 M
INSERT 15 0 0.150260 10880 M
INSERT 15 0 0.200420 14564 M
INSERT 25 0 -0.200090 -14912 M
INSERT 25 0 -0.150040 -11218 M
INSERT 25 0 -0.099860 -7532 M
INSERT 25 0 -0.050070 -3861 M
INSERT 25 0 0.000000 -170 M
INSERT 25 0 0.049810 3506 M
INSERT 25 0 0.100100 7203 M
INSERT 25 0 0.150120 10869 M
INSERT 25 0 0.200080 14540 M
INSERT 35 0 -0.200190 -14854 M
INSERT 35 0 -0.150240 -11183 M
INSERT 35 0 -0.099890 -7493 M
INSERT 35 0 -0.049850 -3811 M
INSERT 35 0 0.000000 -134 M
INSERT 35 0 0.049730 3535 M

INSERT 35 0 0.099900 7222 M
INSERT 35 0 0.150050 10895 M
INSERT 35 0 0.200080 14559 M
INSERT 45 0 -0.200200 -14813 M
INSERT 45 0 -0.150140 -11147 M
INSERT 45 0 -0.099850 -7449 M
INSERT 45 0 -0.049670 -3754 M
INSERT 45 0 0.000000 -96 M
INSERT 45 0 0.049680 3565 M
INSERT 45 0 0.099920 7266 M
INSERT 45 0 0.150160 10937 M
INSERT 45 0 0.200170 14604 M
INSERT 59 0 -0.200170 -14786 M
INSERT 59 0 -0.150130 -11111 M
INSERT 59 0 -0.099870 -7409 M
INSERT 59 0 -0.049620 -3712 M
INSERT 59 0 0.000000 -41 M
INSERT 59 0 0.049690 3634 M
INSERT 59 0 0.100140 7345 M
INSERT 59 0 0.150150 11016 M
INSERT 59 0 0.200190 14687 M
INSERT 64 0 -0.200270 -14772 M
INSERT 64 0 -0.150060 -11082 M
INSERT 64 0 -0.100060 -7396 M
INSERT 64 0 -0.049680 -3652 M
INSERT 64 0 0.000000 -1 M
INSERT 64 0 0.050290 3699 M
INSERT 64 0 0.099560 7343 M
INSERT 64 0 0.150400 11086 M
INSERT 64 0 0.200360 14756 M
INSERT 69 0 -0.200230 -14743 M
INSERT 69 0 -0.150640 -11066 M
INSERT 69 0 -0.100150 -7371 M
INSERT 69 0 -0.049910 -3657 M
INSERT 69 0 0.000000 37 M
INSERT 69 0 0.049990 3741 M
INSERT 69 0 0.099770 7412 M
INSERT 69 0 0.150460 11148 M
INSERT 69 0 0.200270 14807 M
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APPENDIX B - SOFTWARE REVISION 
LOG

Version 1.00 - Initial software release.  January 2011.

Version 1.01 - Updated to support ENCL, DSM and RAD products.  December 2011.

Version 1.02 - Resolved a bug that would not allow the V1.01 to run on a computer that previously had V1.01 installed.  
January 2012.

Version 1.03- Added support for DSAs with temperature segmented calibrations. November 2017. 

Version 1.04 - Added support for DSA-PTP series coefficient files. June 2019.
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